
Adobe PSD
In 1990, Adobe Inc. developed Adobe PSD or widely known as Adobe Photoshop, a raster
computer graphics editor software application for various digital artists, designers, brand
marketers, filmmakers, social media marketers, content creators, and website developers, as
well as aspiring artists and graphic and web design students. It allows users to optimize photos,
produce graphics for websites, and many more.

What is Adobe PSD?
Adobe PSD is a professional graphic editing software program and application that is used by
many professionals in the arts and design field in editing and composing raster images in
multiple layers and supports different color models such as RGB, CMYK, spot color, duotone,
and CIELAB. Apart from Adobe Illustrator, Adobe InDesign, and other design software programs
under Adobe, Adobe PSD offers accuracy, agility, and flexibility to many people when it comes
to transforming images. This program is fundamental for graphics creation, image writing,
website design, and project layout for businesses, organizations, professionals, and other
individuals.

Adobe PSD Definition
Adobe PSD is a functional image editing and design software that provides a wide array of
photo-editing tools for transforming stand-out photos, designing pattern and texture styles,
setting character and paragraph styles, developing brand identity, and creating GIF animations.

Features of Adobe PSD

Enhancing Product Photos
Marketing professionals use Photoshop to create flawless images when it comes to marketing
company products. In Photoshop, you can make your product look visually appealing to the
target consumers and create scroll-stopping graphics on your social media pages by using
brush adjustments, and clone stamp adjustments.

Creating Digital Artworks
This design software offers a variety of brush options suitable for digital painting. Create
breathtaking digital artworks while utilizing brush tip presets, and color fill layers.
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Optimizing Images
One of the common features of Adobe PSD is optimizing images by adjusting the proper color,
touching-up photos, selecting file formats, and reducing file size. The users can also crop,
resize and save their photos in various types of formats.

Creating Photo Manipulations
Adobe Photoshop sets itself apart from other photo editing programs as it lets users manipulate
photos. Photo manipulation integrates elements from multiple images to create something
completely innovative.

Removing Backgrounds and Distractions from a Photo
Users can easily place their subject on a new background by making selections and removing
backgrounds. Use the tools in Photoshop to cut out images, remove specific parts of the image,
or export the image as a transparent PNG.

Turning Photos into Art
With the use of the effects in Photoshop powered by Adobe Sensei AI Technology, it enables
users to transform their photos into artworks. So you can apply an effect to all or part of the
photo using the effect inspired by famous artworks or well-known art styles.

Colorizing Black and White Pictures
If you need to colorize some black and white pictures, Adobe Photoshop is the perfect tool that
you can easily utilize. Change up the colors in your pictures using its automatic colorization
feature.

Designing Logos
Photoshop is an effective software for designing logos for businesses and organizations. There
are many kinds of Adobe Photoshop Logo Templates that you can search online to guide you in
easily customizing your design and making an enticing logo that can increase brand awareness.

Graphic Design Work
If you want to create PNGs, banners, or mockups for marketing collaterals, Adobe PSD is a
powerful tool when it comes to graphic design work. It provides a collection of text, shape, and
effects tools and numerous options for your graphic design projects.



Adobe PSD - Uses, Purpose, Importance
Adobe Photoshop (PSD) offers a variety of uses and purposes for users in diverse fields such
as artists, designers, photographers, filmmakers, animators, and students. Below is a list of the
common uses, purposes, and importance of using Adobe PSD.

Image Editing
Adobe PSD allows users to edit images by cropping, resizing, changing the color, touching up,
repairing flaws, applying a unique filter for graphic designs, and optimizing photos for print and
online use. Thus, many designers use this to improve the overall appearance of their images
when they are designing books, brochures, flyers, posters, and websites for their clients.

Digital Painting
Many graphic designers, and digital illustrators draw, sketch, blend, color, and refine digital
paintings using Photoshop brushes. Make a rough sketch of your drawing, select some colors,
choose some brushes, color block using the layers, and tool presets, and utilize other tools and
options to create fascinating digital artworks.

Brand Identity Design
Aside from Adobe Illustrator, Photoshop is a crucial tool for brand identity design. It helps brand
designers to create logos, business cards, banners, flyers, and other marketing materials for
corporate branding.

Website Designing
Website designers commonly use Photoshop for designing websites as it is capable of pulling
components around the page, modifying colors, and incorporating elements. They are able to
design individual components of the website, slice up graphics into a set of pictures, and export
multiple versions of graphics for mouse rollovers.

Templates
Edit and enhance images and create digital artworks while using this platform. It provides an
extensive collection of prebuilt templates of design formats such as flyers, invitations,
brochures, website backgrounds, etc. Download our editable, downloadable, and printable
Adobe Photoshop (PSD) templates for your design work.
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Adobe PSD Parts

Tools Panel
Located on the left side of the screen, the Tools panel contains wide-ranging tools for editing
your photos. There are also unique features that you can utilize for selection, drawing, painting,
navigation, and many others.

Drawing Tools
Photoshop has drawing tools that you can use for creating your digital artwork such as the Pen
tool, the Eraser tool, and the Brush tool. The Brush tool enables you to draw on the image and
the software offers various brush presets that you can use for digital drawing.

Selection Tools
Use the Selection tools to select all or any part of a picture that you want to edit, copy, cut, or
retouch. Some examples of Selection tools are the crop tool, the slice tool, the move tool, the
marquee tool, the lasso tool, and the magic wand tool.

Menu Bar
The Menu Bar contains different commands that you can utilize while working with your artwork
or design. For instance, the File menu allows you to open and save files, the Image menu is for
making necessary changes in the image, and the Filter menu contains more advanced tools and
effects.

Layers Panel
Located at the lower right corner of the screen, the Layers panel is where you will work on
different layers in your document. It allows the user to maintain efficiency and organization while
working on each component of the digital artwork or image editing project.

Document Window
The Document Window shows open PSD documents that you are working on at the moment.
You will notice the file name at the top of the document window, along with the current zoom
level.

Control Panel
The Control Panel is placed at the top of the screen as it enables you to customize settings for
the currently selected tool. The options in this panel are X and Y location, W and H dimensions,
Scale X ad Y, Rotation and Shear Angle, Rotate and Flip, Fill and Stroke Color, Apply Effect,
Opacity, etc.



Adobe PSD vs Illustrator
Adobe PSD is an image editing, photo manipulation, and graphic design software developed to
help professionals in editing/manipulating images, creating digital paintings, and designing
compelling graphics for books, brochures, magazines, flyers, social media posts, and other
brand marketing materials.

Adobe Illustrator is a vector-based graphic design software created to guide graphic designers
and visual artists in making crystal-clear, high-quality, and intricate designs, branding, logos,
vector graphics, or illustrations.

Adobe PSD Adobe Illustrator

Uses Adobe PSD is made for
image editing, photo
manipulation, photo
enhancements, digital
painting, and graphic design
for brand identity, marketing,
and other arts and design
projects.

Adobe Illustrator is developed
for creating high-resolution
designs, vector artwork, and
digital illustrations.

Pricing Adobe PSD costs about
$20.99 per month for a
single-app subscription plan
and a prepaid annual plan for
$239.88. It also offers a 7-day
free trial for new users.

Adobe Illustrator costs about
$20.99 per month for a
single-app subscription plan
and a prepaid annual plan for
$361.60. There is a 7-day
free trial for new users.

Features Adobe PSD offers quick-click
selections, object removal,
image background
modification, colorization of
black and white images,
image compositions, website
mockups, digitally scanned
images, website layout
designs, real-life painting
simulation, digital painting,
retouching the image and
video file formats, cylindrical
transform warp, guide
enhancements, synchronous
editing, and third party
integrations like Creative
Cloud (CC).

Adobe Illustrator offers
activity tracking, application
management, CAD tools, and
collaboration tools, content
library, content management,
data import/export, drag &
drop, fashion illustrations, file
management, vector
illustrations, image editing,
image library, synchronous
editing, and third party
integrations like Creative
Cloud (CC).



Availability Adobe PSD has several
versions such as Photoshop
CC, Photoshop Elements,
Photoshop Lightroom, and
Photoshop Express. It is
available for use on Android,
iOs, and Windows.

Adobe Illustrator has several
versions such as Illustrator
CS6, Illustrator CC, and
Illustrator Draw. It is available
for use on Android, iOS, and
Windows.

Adobe PSD Tips and Tricks
Adobe PSD has abundant tools and features that aspiring digital illustrators, graphic designers,
and web designers need to be skilled for. Learn about the different ways you can use the layout
design tools in Adobe PSD with effective tips and tricks provided below.

Edit PSD File in Adobe Photoshop
Learn some simple tips on how to edit PSD file in Adobe Photoshop. It has a native file type that
allows your Photoshop works to be saved as high-quality documents.

Convert Adobe XD File to PSD
If you want to change the file format of a file to PSD, go to Photoshop and use the tools and
options that it offers for effective file format conversion. Be informed on the basics of how to
convert Adobe XD files to PSD.

Change a PSD Into JPG in Adobe Photoshop
After working with photo enhancements, change your PSD file in JPG using Photoshop. Learn
how to change a PSD into JPG in Adobe Photoshop so that your file becomes more compatible
with other apps and software.

Setup Color Preference in Adobe Photoshop Color Settings
Understand the color preferences and management in Photoshop. Learn how to set up the color
preference in Adobe Photoshop while working with your digital illustration or graphic design
work.

Convert Adobe Illustrator File to PSD
Do you have some Adobe Illustrator files that you want to edit or make some adjustments to?
Learn some simple methods on how to convert Adobe Illustrator to PSD.
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Create a Metallic Text Effect Using Layer Styles in Adobe Photoshop
Work conveniently on applying metallic text to your document. Know the basics on how to
create a metallic text effect using Layer Styles in Adobe Photoshop.

Add Fonts in Adobe PSD
incorporate fonts and typography art in your digital artwork or graphic design project. Use the
proper tools to add fonts in Adobe PSD.

Create and Modify Brushes in Adobe Photoshop
Need to create and modify brushes for your digital painting in Photoshop? There are some easy
ways to create and modify brushes in Adobe Photoshop.

Use Adobe Photoshop
Create pixel-based pictures for print, mobile apps, and online using Photoshop. Simply learn
how to use Adobe Photoshop effectively so that you can expand your own skillset in photo
editing, image manipulation, digital painting, and web layout design for your business or
personal project.

Convert Sketch Design File into a Layered Photoshop File
It’s quite challenging to convert a Sketch Design file into a PSD file with the layers available to
use. It is essential that you know how to convert Sketch Design File into a layered photoshop
file.

Open Multiple Images as Layers in Adobe Photoshop
Do you want to import many photos as layers into the same Photoshop project? Master the tips
on how to open multiple images as layers in Adobe Photoshop so that you can work on different
images within one project in a breeze.

Print a Poster on Multiple Pages Using Photoshop
Enhance a poster design for your personal use or based on your client’s needs and preferences
by using the tools and unique features of PSD. Just learn how to print a poster on multiple
images using Photoshop when you read the simple instructions and tips here.

Save PSD File for Older Version of Adobe Photoshop
There are numerous different versions of Adobe Photoshop over the years. If you are using an
older version and want to save the latest version PSD file for the older one, learn how to save
PSD file for older version of Adobe Photoshop.
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Merge Two Photos in Adobe Photoshop
Image Editors and photographers use Adobe Photoshop for combining two different photos into
one. Know the basics of how to merge two photos in Adobe Photoshop to upgrade the overall
output of the photo.

Blend Faces in Adobe Photoshop
Do you need to blend a person’s face into another person’s face in your work or personal
project? Blend various faces easily when you learn how to blend faces in Adobe Photoshop
properly.

Remove a White Background or Make it Transparent Adobe PSD
There are several methods to erase a white backdrop or any type of background in Photoshop.
Learn some simple tips on how to remove a white background or make it transparent in Adobe
PSD.

Save Action Set in Adobe Photoshop
Save time and effort while using Photoshop when you make some alterations in the same
process for a series of photos in your work. Learn how to save action set in Adobe Photoshop
so that you can easily get the result you want to accomplish.

Change DPI in PSD to Print High-Quality Photos
Bigger images or pictures may be difficult in maintaining their high-quality resolution. Be
well-informed of DPI or dots per inch when you learn some tips on how to change DPI in PSD to
print high-quality photos so that you are able to improve its appearance.

Crop an Image to a Specific Size in Adobe PSD
Remove unwanted inclusions in your photos using Photoshop. Learn some skills on how to
easily crop an image to a specific size in Adobe PSD.

Resize a Layer in Adobe PSD
Be familiar when working with different layers in Photoshop. Be a pro when you properly resize
a layer in Adobe PSD.

Curve Text in Adobe PSD
Use the right tools to curve text in Adobe PSD for your logo, poster, sticker, or other design
work. Just learn some tips on how to simply curve text in Adobe PSD.
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Change Color of Text in Adobe PSD
Know some ways to modify text color for your digital artwork, brochures, movie posters, or
signages. Learn how to change the color of the text in Adobe PSD using effective tools and
settings.

Apply Texture to an Image in Adobe PSD
Alter the appearance of an image for your client by using various textures. Become familiar with
how to apply texture to an image in Adobe PSD.

Duplicate a Layer in Adobe PSD
Duplicating a layer helps you to make some changes to your artwork or design without having to
create another one so that you can work efficiently and develop comparisons. Learn how to
duplicate a layer in Adobe PSD.

Change Resolution in Photoshop
Level up the resolution of your image using PSD. Learn the tips and tricks to change resolution
in Adobe Photoshop easily.

Edit a PDF in Photoshop
Photoshop helps you in creating and in editing multi-page PDFs without any complexities. Learn
some ways to edit a PDF in Photoshop.

Create a Hyperlink in Adobe PSD
Adding hyperlinks to your images is useful in redirecting your prospects to a certain page you
would want them to visit. Master the effective ways to create a hyperlink in Adobe PSD.

Create A Brochure In Adobe PSD
Brochures helps businesses to make their brands, products, and services known to the public,
especially their target consumers. Use effective ways to create a brochure in Adobe PSD.

Open a New Page In Adobe PSD
Create a blank canvas for your digital illustration or graphic design work. Learn some steps on
how to simply open a new page in Adobe PSD.

Adjust Text And Line Spacing In Adobe PSD
Easily monitor and modify the spacing of your text and lines in your design work in Photoshop.
Follow the basic steps to adjust text and line spacing in Adobe PSD for your documents,
reports, and other online and printed publications.
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Convert PSD/PSB to JPG in Photoshop
Do you want to convert your PSD/PSB file to JPG file format? Learn how to convert PSD/PSB to
JPG in Adobe Photoshop so that you can use your files for other applications with ease.

Create Table in Photoshop
Construct tables for your PDF documents so that you can clearly organize and present your
data. Know some simple steps on how to create table in Photoshop.

Use the Align Tool in Photoshop
Create a clear and cohesive layout for your design work using the align tool. Learn how to use
the align tool in Photoshop appropriately.

Spell Check in Photoshop
Need to check, proofread and revise the text present in your design work? Learn how to spell
check in Photoshop so that you can work with your text with accurate spelling and perfect
typography.

Zoom In/Zoom Out in Adobe Photoshop
Zooming in or out into the smallest details of your digital artwork or design project allows you to
make sure that your work is free of errors or clutters. Learn how to zoom in/zoon out in Adobe
Photoshop so that you can better observe your work and see if you need to make some
additional revisions.

FAQs

What are the essential file formats in Photoshop?
The essential file formats in Photoshop are PSD, JPEG, GIF, PNG, TIFF, EPS and PDF.

What is the file extension in Adobe Photoshop?
The file extension in Photoshop is .PSD.

What are the basics of Adobe Photoshop?
The basics of Adobe Photoshop that every user need to know are opening files, overview of the
Photoshop interface which contains the tools panel, selection tools, and many others, working
with the tools and panels, and customizing the Photoshop workspace.
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What is masking in Photoshop and its types?
Masking in Photoshop is a feature that helps you to manage two or more images in one image,
cut any object from a photo, and remove the background of any photo, and the different types of
masking in PSD are pixel layer masks, vector layer masks, and clipping masks.

Which Adobe Photoshop is best for graphic design?
Adobe Photoshop CC is the best version for graphic design.

What is a layer in Adobe Photoshop?
It is a transparent sheet where you can work on your images or digital painting, and you can
create different layers according to different components of your work.

What are the three of the most important panels in Photoshop?
The three of the most important panels in Photoshop are the Colors panel, Properties panel,
and Layers panel.

What is the size of a logo in Photoshop?
The standard size of a logo in Photoshop is 1200 x 1200 pixels.

How do you merge layers in Adobe Photoshop?
Press Ctrl+E or Cmd+E for Mac or right-click or Control+click for Mac on the selected layers you
want to merge and click Merge Layers.

What are filters in Photoshop?
Filters in Photoshops allows you to incorporate quick effects to your image and the filters can be
combined to create astounding results.


